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A31: A Manual how to make a video and 

integrate new media in traditional classrooms 

 

1. How to make a timelapse video 

A video is made up from 25 single photos per second, that, when placed back-to-

back, trick the mind into seeing motion. But what would happen if someone only 

took one photo every minute, and then played them back at 25 frames per second? 

The result is a magnificent hyper-realistic compression of time. 

We call this a timelapse, and the following link video explains all the steps you need 

to know so you can make your very own: 

https://www.youtube.com/watch?v=AsRhM_Im8fM  

 

One must remember when framing a shot that video does not have the same picture 

ratio as a standard still image. For example Nikon D500 produces a native 3×2 image 

format, being three parts wide, to two parts tall. Video, on the other hand, works in a 

widescreen ratio, which is, as the name suggests, wider than a standard image. 

You you have this you have to chang the shooting mode on the back of the camera 

from live view photo to live view video mode, and by doing that, it produced black 

bars at the top and the bottom of the image, so you know where the edge of the 16×9 

image lay. 

Although 25 frames per second is the standard in European and Commonwealth 

countries, you will notice that there are also 24 or 30 frames per second options, 

which are standard in North America… because they just have to be a little bit 

different. In the end, it only equates to a minute difference, but when shooting for 

minutes and hours, it will make a larger difference in the overall length of the film. 

Lastly, you need to think about how to physically make the timelapse video. There are 

two main ways, an easy way, and a not so easy way. 

If you have a camera such as the Nikon D500, when you will have an built-in 

timelapse feature in the video menu. It will work through all of the complex 

equations, put all the photos back to back, and spit out an MOV movie file 

automatically. 

If your camera doesn’t have a timelapse option, it isn’t a huge problem. You just need 

to take a series of photos at a constant interval, then put them into an external editing 

https://www.youtube.com/watch?v=AsRhM_Im8fM
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software to make those still images into a video. If you are shooting this way, I would 

not recommend shooting in RAW. When you are taking hundreds of thousands of 

photographs, RAW images will unnecessarily consume a lot of card space. We don’t 

even need to shoot in a large JPEG image either. HD video is 1920 pixels by 1080 

pixels, so most “small” JPEG images will be far greater than that, meaning there will 

be zero quality loss when downsampling. 

Before you  invest the full 20 min for the time-lapse, you want to make a quick test of 

1 min. This way you can quickly see if there are any mistakes—exposure, focus, 

framing or anything else. 

A common mistake is to leave your focus set to automatic. The result might mean the 

automatic focusing system will try to find the focus each time before shooting. This 

will create breathing problem if the lens doesn’t focus at the exact same place each 

time, and deliver an uneven final product. To avoid this, first, set your focus and then 

turn your camera’s focus off. You do this by switching mine into manual focus. Once 

you are  satisfied with your test, you reset time to 20 minutes and pressed start. 

https://www.youtube.com/watch?v=v1yasa-3u_E  

For the second timelapse in this tutorial,  the back of the Notre Dame Cathedral was 

chosen. The concept was to shoot during sunset to have the beautiful sunset colours 

and see the scene changed from daylight to street light. 

They were used two cameras for this example—one set in manual mode and the other 

in aperture priority mode with exposure smoothing set on. The result was two very 

different sequences. The Nikon D7000, which was set in manual, kept the same 

exposure through our the sequence and got darker and darker until it just fell off into 

blackness. Whereas the Nikon D500, set to Aperture Priority, continually re-

compensated for the amount of light available, always giving me an even exposure. 

How many photographs do you need for the perfect timelapse? This all depends on 

what you are shooting and how long you want your final video to be. For this shot, 

Ithe photographer knew he wanted the complete sunset, so I set the shooting time to 

one hour. 

If you enter the shooting duration and interval between shots, it automatically 

calculated the output time. 

If you need to do it manually, it is a little more confusing. First, figure out how many 

seconds you will be shooting for. Then divide the shooting duration by the interval, 

giving you the total frames for our output video. Finally, divide the output frames by 

25 (because there are 25 frames per second) and you will have the total output length 

in seconds. 

In this case, it is as follows: 

 Shooting Duration: 1h = 60min = 3,600sec 

 Interval between photos: 13sec 

 Output video: 276 frames = 11 sec 

https://www.youtube.com/watch?v=v1yasa-3u_E
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https://www.youtube.com/watch?v=FW1fdn_VaOU  

the most iconic structure in France was the Eiffel Tower,  for the last timelapse of the 

tutorial. 

He wanted to make something that combined long exposure night photography with 

our time lapse, so the video maker found a beautiful carousel that would create 

delightful light streaks. Because he shot photos and did not just speed up a video file, 

it meant that he could drag out the shutter speed to two seconds. This allowed him to 

capture the light trails I desired in the image. As a bonus, there was a little bit of 

traffic as well, which added some more motion to the shot. 

 

In regards to settings, he shot at an ISO of 100 to minimize the noise, had a shutter 

speed of two seconds so he could have enough time to streak the carousel as it spun, 

and let the camera suggest an f/8 aperture, which looked good to him. He shot in 

manual mode because he did not want any of the lights to pulsate. He also switched 

my White Balance onto fluorescent to counteract the green glow of the street lights, 

this meant it would remain a consistent temperature throughout the sequence. 

 

Finally, he was careful not to shoot at an interval quicker than the shutter speed. The 

shooting duration was 20min, with 5-second intervals, which was more than the 2-

second shutter speed. Running the same math as before, this gave him a 10-second 

output video. The result, was quite pleasant.  

The hyper-realistic passing of time lends itself to timelapse photography. Anything 

with motion will look great—flowers blooming, the sun setting, or a construction 

project. As long as you have motion and movement, it will be a perfect subject. 

Now that you have all of the knowledge to make an excellent time-lapse, go out and 

shoot some beautiful sequences. Let us know how they went by leaving a video in the 

comments below. 

https://www.youtube.com/watch?v=Kku44IDB04g  

Help: Alexander J.E. Bradley is the founder of Aperture Tours (formally Paris 

Photography Tours) and heads up the tours in Paris. A professional photographer for 

over a decade Alexander enjoys shooting the surreal by mixing dreamlike qualities 

into his conceptual images. You can view more of his work on his website. 

 

 

 

https://www.youtube.com/watch?v=FW1fdn_VaOU
https://www.youtube.com/watch?v=Kku44IDB04g
http://www.aperturetours.com/
http://www.alexanderjebradley.com/
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How to Make a Tutorial Video 

If you are a pro at doing something, and want to help other people improve their 

skills, there’s no better way to do it than to make your own video tutorial and share it 

on the web. If your video guide is clear, professional-looking, and informative, you’ll 

be a YouTube star in no time! Movavi has the best video tutorial software you can get 

to create instructional videos on all sorts of computer-related topics like digital 

painting, using applications and web services, and much more! Screen Capture Studio 

combines an all-purpose screen video capture program with a powerful yet easy-to-

use video editor – plus a huge number of quick export settings to optimize your 

recordings for specific mobile devices or for sharing online. 

Download Movavi Screen Capture Studio and find out how to make a how-to video in 

just a few easy steps. 

1. Install the Tutorial Maker 

After downloading the installation package to your computer, open it and install the 

software following the guidelines on your screen. 

2. Record Footage for Your Tutorial 

Start Screen Capture Studio and you’ll see all the available options in the launcher 

window. If you’re creating a software video guide or other computer-related tutorial, 

choose Record screen to start the screen capture process. If you don’t want screen 

footage for your tutorial, skip this step and go to Step 3 to learn how to record 

webcam video and import footage from other sources. 

To start capturing your screen, draw the capture frame over the area of the screen you 

want to record. This will give you access to additional capture settings. Adjust the 

frame size by pulling on its edges until it’s positioned correctly; alternatively, you can 

choose one of the preset sizes or full screen mode. You can do even more to make 

your tutorial extra-clear: record audio commentary or webcam footage during the 

screen video capture, use the built-in visual and sound effects to emphasize cursor and 

mouse clicks, and even capture keyboard actions. To start the recording, click REC. 
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If you use Windows, you can also start capturing the screen by pressing F10 on your 

keyboard. Pressing F10again will stop the capture. To do the same on Mac, press ⌥ 

⌘ 2. Read our screen capturing tutorial for more tips and tricks. 

3. Record Additional Video 

After the program is finished recording, you'll see a preview window where you can 

review the resulting footage. Click the Open in Editor button to load your footage 

into the Video Editor; this is where you can add more content. If you haven’t recorded 

screen footage, you can start the Video Editor directly from the launcher window by 

hitting Edit video. 

To make your tutorial more personal and appealing to the audience, you can 

also capture webcam video. In the main window of the video editor, click the Record 

Video icon to open the capture module; the software will detect your built-in camera 

automatically. If you’re using an external webcam, don’t forget to connect it to the 

computer first! 

https://www.movavi.com/support/how-to/how-to-record-desktop.html
https://www.movavi.com/support/how-to/how-to-capture-webcam.html
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You will be able to see yourself in the preview window. Adjust the camera to find the 

best angle and click Start Capture. To finish recording, click Stop Capture – your 

file will be saved automatically. Click Back to editing to return to the video editing 

module and automatically add the recorded video onto the timeline. 

4. Edit Your Video 

Now that you’ve added all the footage you want to use, it’s time for the final tutorial 

creation! Turn your raw material into a professional-looking explainer video by 

editing it to perfection. Here’s what you can do: 

 improve the quality of your video using correction tools 

 cut, trim, and merge your files on the timeline 

 use animated transitions to link different parts of your video 

 apply special effects to make your video black and white, rotate images, etc. 

 add background music and record your own voiceover commentary 

 add titles, captions, and other text elements to your video tutorial. 

https://www.movavi.com/support/how-to/enhance.html
https://www.movavi.com/support/how-to/how-to-split-videos.html
https://www.movavi.com/support/how-to/how-to-trim-video.html
https://www.movavi.com/support/how-to/how-to-join-videos.html
https://www.movavi.com/support/how-to/how-to-add-video-transitions.html
https://www.movavi.com/support/how-to/effects.html
https://www.movavi.com/support/how-to/how-to-add-audio-to-video.html
https://www.movavi.com/support/how-to/how-to-add-subtitles-to-video.html
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5. Export the Tutorial or Optimize It for the Web 

The final step is making your brand new video tutorial available to the world. 

Click Export to see all the available options: 

 Save as video will export the tutorial in the popular video format of your 

choice 

 The presets For Apple devices, For Android devices, and For other 

devices let you optimize the video for playback on mobile platforms 

 For uploading online prepares the video guide for easy upload to YouTube, 

Facebook and other video hosting platforms. 

  

Now you know how to capture video from website in the most efficient way and keep 

it on your hard drive. Add some creativity and turn your recording into a featured 

video with Movavi Screen Capture Studio. 
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How to make a video using Windows Movie maker 

Getting started 

Open the program and start a new project by going to File > New Project. Save your 

new project under any name you’d like, and choose a destination for the project to 

save to. We recommend saving as often as possible while working to avoid losing any 

editing progress–in the event the program or operating system crashes or freezes. 

The Interface 

 

Interface 

 

Windows Movie Maker has three regions you use while editing your video. The top 

of the program is the Ribbon and it’s where you’ll access the various editing tools 

such as transitions, effects, captions, audio levels, and more. You’ll also add any 

video, photos, or audio via the add tool located on the Ribbon and can quickly save 

your project with the disk icon located there as well. 

 

Below the Ribbon and to the left side of the program is the preview window. The 

preview window is where you view the video playback of your project and can see 

what the sequence would look like as a finished product. You can use the rewind, fast 

forward, or play button in the preview window and can also toggle full screen view 

for your preview. 
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The window located underneath the Ribbon on the right side is your storyboard, or 

timeline, window. This is the location of your video sequence and it also contains 

your imported video clips. The storyboard/timeline window is where you navigate 

through your clips, split them when necessary, and arrange them in the sequence. 

 

Uploading videos and photos 

 

With the interface more familiar and a new project created you’re able to get started 

with the program itself. First, you need to decide what it is you wish to edit in the 

program. Movie Maker offers several different ways to easily upload various video, 

photo, and audio files in to the program. 

 

How to upload an entire video from a digital video (DV) camera tape 

 

For users who have video stored on a digital video (DV) camera tape connect the 

camera to your computer via an IEEE 1394 connection or a USB 2.0 connection and 

set your camera to play back recorded video. 

 

Note: On most DV cameras the play back recorded video button says VCR or VTR. 

 

When the camera turns on the program will recognize the device and will display an 

Autoplay dialog box. Once this pops up select Import Video, name the video file 

you’re importing, and then save the import to your computer. 

 

The program will ask you which format you’d like to import the video to and you’re 

given the option of formatting to Audio Video Interleaved (AVI and DV-AVI) or 

Windows Media Video File (WMV). Formatting to AVI or DV-AVI will import your 

video using the default file type of your digital video camera while formatting to 

WMV assures that the information on the video is Windows compatible. 

 

If the Autoplay dialog box doesn’t pop up when you turn your camera on just go to 

File > Import from device, select the source you wish to upload from then click 

Import. 
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ImportDevice 

Once you select your desired format click Import the entire videotape to my computer 

and then select Next to begin the upload process. When it’s complete just click Finish 

and your video is completely uploaded. 

 

How to upload clips of a video from a digital video (DV) camera tape 

 

If you’re not wanting to upload the entire contents of your DV tape Windows Movie 

Maker allows for uploading shorter clips in to the editor. Following the same 

directions above for connecting your camera and selecting a format to upload to 

you’ll want to then select Only import parts of the videotape to my computer then 

Next. Now navigate to the start of the clip(s) you want to import and choose Start 

Video Import. 

 

Once you’ve started importing the video will begin playing automatically. When you 

get to the end point in the clip you want uploaded just click Stop Video Import and 

the video imports and saves as an individual clip. Simply repeat hitting Start and Stop 

Video Import for each of the clips you wish to upload. 
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How to upload photo and audio files 

 

Importing photo and audio files into Windows Movie Maker is simple and requires 

just a couple steps. While in the Movie Maker window click Add videos and photos 

and locate where on your computer the files are you wish to upload. Highlight the 

files and click Open to upload them in to the program. 

 

Editing video clips 

With the content you wish to edit uploaded to your computer we can begin taking a 

look at the editing process. 

If the uploaded video is not yet in the Movie Maker program navigate to the Add 

videos and photos button located under the Home tab. Locate the files you wish to 

import and select Open to add them to your movie’s timeline. The program will 

automatically break the sequence up in to 10 second segments for easy navigation of 

the timeline. Your sequence stays as one fluid video so you’ll still need to split any 

part of the clip you wish to edit singularly or delete. 

Splitting clips 

To cut up any video imported to Movie Maker first navigate to the Edit tab under 

Video Tools and locate the Split button. In your video sequence either drag the black 

cursor or play the video and hit stop where you want to split your clip and click Split. 

Movie Maker will now split the clip at the exact time you’ve chosen and has created 

two separate clips. You’ll need to split your clip a second time to create an individual 

clip you can either move to another part of the sequence, add a transition to, or delete 

altogether. 
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Trimming clips 

Trimming clips in your sequence is a worthwhile tool if you want to get rid of a part 

of a clip, but not delete it entirely. Movie Maker’s Trim tool allows you to select a 

clip within your sequence and trim as much out of the middle of the clip as you want 

and it will join the beginning and end to form a new sequence. The trimmed part of 

the clip does not delete, rather the program hides what you’ve trimmed and will not 

show up during playback. 

 

Adjusting audio levels 

You’ll also notice the video levels displayed over the top of your video clips in the 

timeline. This allows you to match up the audio for each clip to assure the same 

volume is consistent throughout your video. To change the audio levels of a clip 

navigate to the Edit tab under Video Tools and select video volume to adjust the 

sound level. Once adjusted, the specific clip selected is the only one to have its audio 

adjusted. If you want to adjust only a few seconds of a clip split the clip at the end of 

the sequence you wish to adjust and change the volume for that clip alone. 

 

B: How you integrade new media in traditional classrooms? 

Social media has changed how we approach many facets of life in the 

21st century, including everything from our interpersonal relationships to 

how we consume and filter media. Many teachers used to (and still do) 

shun social media from the classroom, claiming it distracts students and 

raises privacy concerns. However, more progressive educators are 

realizing platforms like Facebook and Twitter are already integral parts of 

their students’ lives and are learning how to use social media for 

educational purposes in the classroom. Here are 5 ways social media has 

changed the traditional classroom. 

1. It Changes How Teachers and Students Communicate, 2. It Enhances 

Peer Collaboration, 3. It Helps Students Follow Current Events, 4. It 
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Teaches Them Appropriate Online Behavior, 5. It Keeps Their Minds 

Working, Even During Leisure Time. 

Just by using your cell phone as a start, you are able to video your 

students progress, record their voices and then evaluate the development 

in your lesson and then by using a usb cable you just transfer all in your 

computer.  

Technology has got so much simplify abilities in a teachers hand. 

Students use it in their everyday life and a teacher must integrate all new 

media in even a very traditional classroom.  

A grade article about 12 ways to integrate Media Literacy and critical 

thinking into any curriculum can be found in the following link: 

https://www.projectlooksharp.org/12BasicWays.pdf 

Also on the following link another research article enhances the idea of 

media in a classroom today: 

http://education.mit.edu/wp-

content/uploads/2015/01/GamesSimsSocNets_EdArcade.pdf  

However, if you feel uncomfortable to video – record and proceed a 

video product, start by taking them photos. You will notice as a teacher 

that immediately students get connected with you because it’s an 

everyday habit. So, integrate new media by creating posters or any kind 

of work that connects with your curriculum. Students – if they are older – 

will create themselves videos and even teach you. Enjoy your learning 

and teaching. 

 

Hara Haralambous 

Frenaros Primary School 

Coordinator of the project 

arts@creativity.eu  

2015-2018 
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